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CHAPTER 1. INTRODUCTION 
LabSmith’s uProcess™ is a platform comprised of a suite of hardware and software products 
that simplify construction and control of microfluidic systems.  

uProcess automated devices work together with CapTite™ microfluidic interconnect products to 
make it easy to build and rebuild micro- and nano-fluidic circuits. All products are inter-
compatible and quick to assemble, taking the hassle out of fluid routing. 

 SPS01 Programmable Syringe Pumps deliver volumes up to 100 microliters, with 
resolution as low as 2 nanoliters. The pump body design allows syringes to be easily 
removed and replaced, providing a wide range of volumes with a single pump.  

 AV201 Automated Selector Valves provide 2-position, 3-port switching, with zero dead 
volumes and low swept volumes. 

 AV202 Automated Selector Valves provide 2-position, 4-port switching, with zero dead 
volumes and low swept volumes. 

 uPS Pressure Sensors provide pressure sensing and regulation. 

The uProcess Software provides a simple interface for configuring and controlling uProcess 
devices and for creating automated processes for coordinated control.  

This user guide will show you how to connect, configure and control uProcess devices, how to 
install and operate uProcess software, and how to create automated flow control processes.  

Please contact LabSmith or visit www.labsmith.com for user manual, software and firmware 
updates. 

Equipment List 
uProcess software communicates with uProcess devices through the Electronic Interface 
Board (EIB). The EIB is typically connected via communication cable through one of the 
LabSmith breadboards (uPB, iBB, etc.), enabling control over multiple devices (Figure 1).  

 
Figure 1. uProcess System Components. 
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The EIB can also connect directly to a single SPS01 syringe pump, to a 4VM01 valve manifold, 
or to a 4AM01 analog manifold, without a breadboard.  

The EIB connects to the computer via the RS232 cable, or to a USB port with optional RS232 to 
USB adapter.  

Required Equipment 
- PC-compatible computer running Windows® XP, NT, 7 or 8 

- Electronic Interface Board (EIB) 

- uProcess™ software (installation disk included) – included with EIB 
purchase 

- 12V power supply for EIB – included with EIB purchase 

- RS232 serial interface cable – included with EIB purchase 

- 20-pin communication cable – included with EIB purchase 

 

Additional required and optional equipment for syringe pumps 

- SPS01 Programmable Syringe Pump  

- SPS01 syringe glass/plunger set – included with SPS01 purchase 

- CapTite ferrule (C360-100 or T116-100) for connecting to capillary or 
tubing 

- syringe glass/plunger installation tools (plunger wrench and 3/32” hex 
wrench) 

- installation screws (qty 2 x M3),  optional 

 

Additional required and optional equipment for automated valves 

- AV201 or AV202 automated valve 

- 4VM01 valve manifold (one manifold per up to four valves) 

- flat ribbon connector (one per valve) – included with 4VM01 purchase 

- Three (3) CapTite ferrules (C360-100, T132-100, or T116-100) for 
connecting to capillary or tubing 

- breadboard mounting screws (2-28x1/4”), two per valve, optional 

 

Additional equipment required for pressure sensors 

- uPS pressure sensor 

- 4AM01 analog manifold (one manifold per up to four sensors) 

- flat ribbon connector (one per sensor) –4 x included with 4AM01 
purchase 

- CapTite component (-C360, -T132, or –T116) with female port for 
installing sensor 

Optional Equipment 
- uPB or iBB breadboard 

- RS232 to USB adapter cable 
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Cautions and Warnings 
When working with uProcess devices and accompanying electronics, follow standard 
procedures to protect your devices from excessive static electricity, power fluctuations, etc. 

Read and understand all documentation for your individual uProcess devices and components 
before connecting the equipment. 

CAUTION: Extra care must be taken when using the electronic components with fluids. 
Breadboards are designed with the electronics on once side; use precautions 
when introducing liquids to this side of the breadboard.  

Getting Help 
This guide is your main source for information on operating uProcess software. Choose 
Help>About uProcess, then click the Open User Manual link to browse this manual 
electronically, in Adobe® Acrobat® PDF format. 

The LabSmith web site (www.labsmith.com) also includes helpful applications notes and other 
technical information to help you use uProcess software and devices. If you are unable to find 
the information you need, please contact our technical support team at (925) 292-5161, or email 
us at support@labsmith.com. Be prepared to give the software version. To determine the 
software version number, select Help>About uProcess. 

About This Manual 
Several conventions are used throughout this manual to highlight important features and 
concepts: 

Menu>Option Menu bar selections will be shown in bold text, with descending options 
separated by the “>” symbol. For example, Help>About uProcess indicates that you should 
click the Help menu, and then click About uProcess. 

Note Notes indicate helpful tips or additional information. 

CAUTION These notes signify important considerations that will help you to avoid losing data 
or damaging hardware. 

Italics When browsing the electronic version of this manual, click on these italic cross-
references to view other pertinent sections of the manual.  

 

Choose Help>About uProcess, then click the Open User Manual link to browse the electronic 
version of this manual. 



 

8 

CHAPTER 2. GETTING STARTED  

Connecting an Electronic Interface Board 
Though the devices you use with your uProcess system will vary, some basic hardware is 
common to all uProcess setups.  

Every system requires at least one Electronic Interface Board (EIB), which can control up to 110 
SPS01 Syringe Pumps, 4VM01 Valve Manifolds, and/or 4AM01 Analog Manifolds. Since each 
manifold can control up to four devices, one EIB can thereby control hundreds of devices. 

Although over 100 devices can be sequentially controlled using a single EIB, the number of 
devices simulaneously actuate is limited and depends on the type of device being actuated. 
Multiple EIBs can be used at one time when a large number of devices or concurrent operations 
are required. 

 

To connect an EIB to the computer:  

 Connect the serial interface cable from the COM port on the EIB to the computer’s 
RS232 port. An optional RS232 to USB adapter allows you to connect the EIB to a USB 
port instead. 

 Connect the power transformer from the EIB to a wall outlet. The two indicator lights will 
flash when powered up, after which the Power light will stay illuminated red. The COM 
light will illuminate when the EIB is communicating with the computer.  

Adding a Breadboard 
An EIB can be connected to a single syringe pump, valve manifold, or analog manifold; 
however, it is typically used with one of the LabSmith breadboards (uPB-5, uPB-8, uPB-12, or 
iBB) for mounting multiple components (Figure 2). Between 5 and 12 uDevices (syringe pumps, 
valve manifolds, analog manifolds) can be connected to a single breadboard.  

To add a breadboard, connect the 20-pin communication cable from the Device Bus port on the 
EIB to one of the female connectors on the breadboard. Line up the tab on the communication 
cable with the notch on the connector.  

The larger breadboards (uPB-8, uPB-12, and iBB) can be daisy-chained together by installing a 
20-pin communication cable between female connectors on each board.  
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Figure 2. uPB-05 and uPB-08 Breadboards with uDevices. 

The following sections provide information on installing the various devices available for the 
uProcess system.   

Note: it is best to disconnect power to the EIB before adding or removing devices 

Installing Automated Valves 
To install and configure AV201 or AV202 automated valves: 

 Plug the 4VM01 valve manifold into one of the connectors located along the side of the 
breadboard. 

 Secure the automated valve(s) to the desired location on the breadboard using two ¼” 
breadboard mounting screws (optional). 

 Use a ribbon cable to connect the automated valve to a port on the valve manifold. 
Observe the label on the valve and manifold to ensure the cable is connected at the 
correct orientation. 

 Upon power up, the LED on the 4VM01 will flash red/green and then glow steady green.  
The valve LED does not illuminate during power up. 

Installing Syringe Pumps 
To install an SPS01 programmable syringe pump, plug the syringe pump body into one of the 
connectors located along the side of the breadboard. Two M3 screws may optionally be used to 
more securely attach the syringe to the bottom of the breadboard. 

Upon power up, the LED on the SPS01 will flash red/green and then go out. 

 

Installing Pressure Sensors 
To install and configure uPS pressure sensors: 

 Plug the 4AM01 sensor manifold into one of the connectors located along the side of the 
breadboard. 
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 Secure the pressure sensor(s) to the desired component.  Note: the uPS360 sensors 
can be installed in a –C360 or –T132 CapTite component (for use with 360m OD tubing 
or 1/32” OD tubing, respectively) The uPS116 sensors can be installed in a –T116 
component, for use with 1/16” OD tubing. 

 Use a ribbon cable to connect the pressure sensor to a port on the analog manifold. 
Observe the label on the manifold to ensure the cable is connected at the correct 
orientation.  

Note: the orientation of the connector on the 4AM01 is the opposite of the orientation of the 
connector on the 4VM01. 

 Connect the ribbon cable to the uPS sensor with the following orientation: 

 

Upon power up, the LED on the 4AM01 will flash red/green and then go out. 

Installing uProcess Software 
uProcess software runs on any PC-compatible computer running Microsoft Windows® XP, NT, 
7, or 8. The software requires approximately 5MB of free disk space. To install uProcess: 

 Insert the uProcess for Windows CD. 

 Double-click SETUP.EXE and follow the on-screen instructions. 

 To run the software, double-click the uProcess icon on your desktop, or choose 
Run>uProcess>uProcess. 

 The uProcess software can also be downloaded from the LabSmith website 
(www.labsmith.com) .  We recommend visiting the website occasionally to check for 
software updates.  
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CHAPTER 3. uPROCESS SOFTWARE 

Software Interface 
The uProcess Dashboard consists of a menu bar, toolbar, and configurable windows (Figure 
3). Unique menu and toolbar commands will be described in the body of the text below. A 
complete listing of all menu and toolbar commands can be found in Appendix A. Menus, 
Toolbars, Window Controls. 

 
Figure 3. uProcess Dashboard. 

The uProcess Dashboard consists of 5 windows, described below. You can customize the 
placement of the windows on the dashboard and a number of other features about the interface. 
See Customizing the Dashboard for more information. 

uDevices Window 

The uDevices Window is used to view, add, and configure individual devices and EIBs (Figure 
4).  It shares the left side of the Dashboard with the Sequencer Window. Click the tabs at the 
bottom of this area to switch between the two windows.  
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Figure 4. uDevices Window. 

Sequencer Window 

The Sequencer Window is used to view a sequence program (Figure 5). The uDevices Window 
is used to view, add, and configure individual devices and EIBs.  It shares the left side of the 
Dashboard with the Sequencer Window. Click the tabs at the bottom of this area to switch 
between the two windows.  

 
Figure 5. Sequencer Window. 

Output Window 

The Output Window is used to monitor device communications or to debug and monitor a 
sequence program (Figure 6). By default this window appears at the bottom of the dashboard.  
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Figure 6. Output Window Showing Script Parsing Tab. 

The Output Window contains three tabs: 

Script Parsing displays any errors in the current automated process. 

Sequence Status indicates which process is running and notes any errors incurred. 

Communications shows the status and history of communication between the Electronic 
Interface Board and the computer. 

Main Window 

The Main Window is used to control and monitor devices, as well as to construct, edit, and 
monitor sequence programs. Its contents change depending upon what is selected in the 
uDevices Window or Sequencer Window. The Main Window cannot be undocked or hidden. 

Communicating with the uDevices 
Once the uDevice hardware and uProcess software have been installed you are ready to 
communicate with the devices. 

Launch the uProcess software. 

Right-click on Interfaces in the uDevices Window and choose New Interface.  

Select the computer port to which the EIB is connected, and click OK. If multiple EIBs are 
installed, repeat this step for each EIB. 

Your uProcess dashboard should now look similar to Figure 7. 
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Figure 7. uProcess Dashboard. 

The uDevices Window contains a tree structure listing each EIB and the devices installed 
under each. In Figure 7 two EIBs are connected. Two SPS01 syringe pumps and a 4VM are 
connected to the EIB on COM6. A SPS01 syringe pump is connected to the EIB on COM5.  

Note: Breadboards will not appear as device in the uDevices tab since there are no functions 
to control on the breadboard itself. 

With the uDevice window selected, the Main Window will show one of two views: the Control 
Overview Window or the Individual Device Control Panel. 

The Control Overview Window allows limited control of all devices. It is also the view that will 
be used to program sequences using the programming wizard (see Create a Script Using the 
Wizard). 

By clicking on one of the individual device names in the uDevices Window, the Individual 
Device Control Panel opens. Figure 8 shows the control panel for a syringe pump, Figure 9 
shows controls for a 4VM01 valve manifold.  Figure 9 shows controls for a 4AM01 analog 
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manifold.  The Individual Device Control Panel provides a wider range of control and setting 
options for an individual device than is available in the Control Overview Window. 

 

 
Figure 8. Control Panel for Syringe Pump. 

 

 
Figure 9. Control Panel for Valve Manifold.  Valves installed in position 1 and 3. 
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Figure 10 Control Panel for Analog Manifold. uPS pressure sensors installed in positions 1, 2, and 3. 

Online and Offline 
The communication status of each device is shown in the uDevices Window. To monitor or 
control a device, the device, its EIB, and the interface must all be online. 

As shown in Error! Reference source not found., the icon to the left of each device will 
indicate whether it is Offline (not in communication with the computer) or Online (in 
communication). In this example the EIB on COM11 is offline, and the EIB on COM1 is online.  

To change the status of a device or EIB, right-click the device in the uDevices Window and 
check/uncheck the Online setting. 

To toggle all connected devices to online or offline, click the Online toolbar button . 

Note:  An EIB will go offline if there is a communication error between the COM port and the 
EIB. Two red lights on the EIB also indicate a communication problem. This error often 
indicates a bad cable connection. The Communications tab of the Output Window 
lists the EIB port communication status and history.  
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Figure 11 Devices Shown Offline (EIB on Com11) and Online (EIB on COM1). 

Device Naming and Numbering 
Every uDevice (syringe pump, valve manifold, or analog manifold) is identified by an address 
and name. The uPS pressure sensors also are individually named 

Note:  Clicking on the device name in the uDevices Window  will cause the indicator light on 
 the device to flash red/green. This feature aids in quickly identifying each device.  

Device Address 

Each device attached to an EIB must be assigned a unique address between 0 and 110. If you 
purchased several devices at the same time from LabSmith they will be preconfigured with 
unique addresses.  

Device addresses are shown next to each device in the uDevices Window and also on in the 
Address field of the  

Note: If multiple devices on the same EIB have identical addresses they may not appear in 
the uDevices Window list, or they may appear as one device. Operating in this 
condition can cause unpredictable results.  

 If two devices with the same address are installed, one will need to be removed before 
the address can be changed.  

Note:  The address assigned to each device is independent of its physical position on a 
breadboard. Devices will be displayed in numerical order on the control panel for each 
EIB based on the device address, not the position on the breadboard. 

To change a device address: 

Select the device in the uDevices Window. 

Choose Configuration. 

Select a Device Address from the dropdown menu and click OK.  

You can also right-click on the device icon in the uDevices Window and choose Change 
Address. 

Device Name 

Your uDevices will arrive with a default name: “LabSmith SPS01” for the syringe pump, 
“LabSmith 4VM” for the 4VM01; and “LabSmith 4AM” for the 4AM01. 
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You can rename the devices. The name may have a maximum of 16 characters and may not 
include ‘;’, ‘<’, ‘>’, ‘*’ or ‘=’. Names may include tabs and spaces but may not start or end with 
them. Names are case-sensitive.  

If you will be using automated processes, each installed device name must be unique.  

To change a device name: 

Select the device in the uDevices Window. 

Choose Configuration. 

Type the new device name in the Name field.  

You can also right-click on the device icon in the uDevices Window and choose Rename. 

Each pressure sensor arrives with the last four numbers of the serial number as the sensor 
name.  Please see the sensor configuration section of the user’s manual for information on 
changing the sensor name. 

Adding or Removing uDevices 

To add or remove a device: 

- Click the Online toolbar button  to toggle all interfaces offline. 

- Physically add or remove the uDevice(s) to or from the breadboard. 

- Click the Online toolbar button  to toggle all interfaces back online. 

Click the Rescan toolbar button  to check for new devices. Any added devices should now 

appear in the uDevices Window, while any removed devices will be gone. 

Note:  To rescan an individual EIB right-click its icon in the uDevices Window, then choose 
Rescan Devices. 

 

Saving Data into a Log File 
Time-resolved data can be saved into a log file (format .csv) for later viewing and plotting.  
Choose  File>Log Status/Measurements... to create a log file.  When log file data is being 
collected there will be a check mark next to the “Log Status/Measurements...” item in the menu.  
The file will continue to collect data until you uncheck the box, close the software, or change any 
of the uDevices (add or remove devices).   

Log file preferences are set using View>Status/Meas Logging Options..., which brings up the 
Status Tracing Settings window. 
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Settings such as data recording rate, file time, file auto-naming are controlled from the Status 
tracing Settings window. 

External Instruments 
The uProcess software supports several third-party instruments.  These instruments are 
connected to the computer via USB or RS-232 connection and, depending on the instrument, 
can be monitored and/or controlled.  Contact LabSmith support (support@labsmith.com) for 
information and instructions on supported instruments. 
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CHAPTER 4. REAL TIME DEVICE CONTROL 
uProcess lets you control connected devices manually or as part of an automated process.  
uDevice control can be accessed two ways: 

 through the Control Overview Window (accessed by clicking on the Interfaces heading 
in the uDevices window) 

 or through an individual Device Control Panel, which can be accessed by clicking on 
the device name in the uDevices window 

  

 

The Control Overview Window gives you a convenient way to view and set the controls for 
multiple devices, which is particularly useful when setting up the steps of an automated process, 
or when controlling multiple devices via pressure regulation.  Figure 12 shows a typical Control 
Overview Window.  The individual Device Control Panels can be selected for additional 
controls for the particular devices.   

Click to access Control Overview Window 

Click an individual device to access 
it’s Device Control Panel 
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Figure 12 Example of Control Overview Window 

uDevice Controls  
Individual uDevices can be controlled via the Device Control Overview Window (shown in Figure 
12) or via its individual Device Control Panel.  The controls for each type of uDevice are 
described below.  

 

Analog Manifold Control 
The analog manifold controls are used to monitor and control the uPS pressure sensors.  
Typical Control Overview Window and Analog Manifold Control Panel views are shown in Figure 
13 and Figure 14, respectively.   
 

 
Figure 13 Typical Control Overview Window view of analog manifold controls. 
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Figure 14 Typical Analog Manifold Control Panel view.  

The following commands and information are available for each connected uPS pressure 
sensor: 

 4AM01 Name   Set name for the 4AM01 
 Sensor Name   Set name for the pressure sensor 
 Pressure Reading  Current sensor pressure reading 
 Regulation Pressure  The regulation pressure can be set by moving the   

    slider bar, or by typing the desired pressure in the pressure 
     reading box  

 Ambient Temperature*  This is the pressure sensor ambient temperature, not the  
    fluid temperature. 

 Scale*    Indicates pressure scale for slider bar (scale can be set in  
    the Configuration window) 

 
* ambient temperature and scale are not displayed in the Control Overview Window 

 
Regulation Status Indicators show the current regulation status (regulating up, regulating down, 
regulation satisfied, unregulated).  See Channel Regulation below for more information. 
 
Clicking on “Reg..” or “Regulate...”  brings up the Regulation Settings Window, as shown in 
Figure 15.  From this window you can set the regulation target reading and choose a hardware 
channel to output the regulation status.   
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Figure 15 Regulation Setting Window 

 
The following options are available for the Regulation Settings Window: 
 
Target reading:  input target pressure value in specified units 

 Check too low: the sensor will regulate up to the input value 
 Check too high: the sensor will regulate down to the input value, when the actual 

pressure is equal to or below the target reading the regulation will be complete. 
 If both Check too low and Check too high are selected, the sensor will regulate both 

up and down. 
 
Tolerance: input +/- tolerance for target reading.   

 
 The sensor will regulate until the pressure value is within the target +/- tolerance. 

 
 Hysteresis:  checking this option causes the pressure to regulate to the target value, 

and then the regulation stops until the pressure falls outside the tolerance level.  
 
  
Channel Regulation: check the box and select the channel to send the regulation status to an 
EIB hardware channel.  Channel regulation can be used to couple the pressure sensor to a 
SPS01 syringe pump or automated valve to actuate the syringe or valve based on the pressure 
regulation status. 
 
If a hardware channel is selected, the channel status will be shown on the EIB control window 
and the analog sensor panel.  Regulation Status Indicators include: 
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   Regulating Up 

   Regulation satisfied 

   Regulating down 

   Unregulated 

   Regulation pending, but not set 
 
For the example shown below:  

 uPS 0041  is unregulated 
 uPS 073X  is regulating up and set to hardware channel B 
 uPS 066S  has is pending, but not set so the regulation type is unknown (the   

  user would press ‘apply settings now’  to set the programming) 

 uPS 072X  is regulating down and is set to hardware channel C 
 

 
 
4AM01 and Sensor Configuration Settings 

Several configuration settings are available to optimize performance of the 4AM01 and pressure 
sensors.  Click on the ‘Configuration…’ button of the 4AM01 device window to open the 
Configure LabSmith 4AM window shown in Figure 16. 
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Figure 16 4AM01 Configuration Settings 

The gain setting is used to optimize the gain for device and scale range of interest.  For the uPS 
pressure sensors, the gain readings should be applied as follows: 

 Off: does not sample sensor 
 x1: not applicable for uPS pressure sensors 
 x20: for full-scale pressure readings (default for uPS pressure sensors) 
 x200: for applications where the pressures will be up to a max of ~10% of full scale 

 
Therefore, for a uPS01-800 pressure sensor, if the measured pressures are expected to be less 
than 80 kPa, use the x200 gain setting for the most accurate results.   
 
The default sampling rate is 1.8 kS/s.  This rate has the lowest noise and will be suitable for 
most applications. 

Zero Offset 
The zero reading on the pressure sensors will drift slightly (typically less than ~+/-2 kPa) over 
time, especially if there are large swings in the sensor temperature.  We recommend that you 
occasionally re-zero the sensors to eliminate the zero offset.   
 
Procedure: 

1. Power up the sensors and 4AM and wait for about 5 minutes for the 4AM to warm up. 
2. Click on each sensor to bring up its Sensor Properties window (Figure 17) 
3. Click the ‘Zero Reading’ button to zero the pressure sensor.  

  



 

26 

 
Figure 17 Sensor Properties Window 

 
The Sensor Properties Window provides the following additional controls 

 Sensor Name:  the default name is the last 4 numbers of the Sensor serial   
   number 

 Display Units:  default units are kPa, a conversion factor can be input to display  
   the pressure in units other than kPa 

 Display limits:  these are the limits displayed in the Control Overview Window  
   and the Analog Manifold Control Panel 

 Calibration:  please contact LabSmith before changing the calibration 
 Factory Settings: please contact LabSmith before changing the factory settings 

Syringe Pump Control  

Syringe pump control of set volume, flow rate, and pressure regulation settings can be 
manipulated via the Device Control Overview Window, as shown in Figure 18. The Syringe 
Pump uDevice Control Panel (Figure 19) provides additional position control options and 
Configuration settings. 
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Figure 18 Syringe pump control options in the Device Control Overview Windown 

 

 
Figure 19 Additional syringe pump control options available in the Syringe Pump uDevice Control Panel. 

 

Target Volume is set by dragging the volume slider, or entering the desired volume in the 
Target volume box.   

Flow Rate is set by dragging the flow rate slider, or entering the desired rate in the Flow rate 
box.  

 Note: If Update All uDevices Continuously ( ) is selected, changes in target 
 volume or flow rate are immediately applied.  If not selected, the pump settings will not 

 change until Apply All Settings Now ( ) or  is selected. 

 

The Motion Indicator shows the pump motion 

  green indicates that the pump is pushing 

  red indicates that pump is pulling 

max volume 

actual volume 

pressure regulation

set volume set flow rate 

motion indicator max flow ratemin flow rate 

uDevice name 

min volume 

Move in increments of... 

access 
configuration 
settings 

 Move in increments (max, 10%, 1%, 0.1% of range)

syringe size (can be adjusted in Configuration...)
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  grey indicates the pump is stationary 

  a red X next to the syringe tip indicates the pump is stalled 

 

The syringe pump can be used to regulate pressure by clicking on the Set motion via Ch. until 
the desired Channel setting is selected.  The Channel Setting options are: 

  Move with Ch. X   

  Syringe pump will “push” when pressure on Ch X is below the desired setting. 

  Syringe pump will “pull” when pressure on Ch X is above the desired setting. 

  Move opp. Ch. X 

  Syringe pump will “pull” when pressure on Ch X is below the desired setting. 

  Syringe pump will “push” when pressure on Ch X is above the desired setting. 

 

 Note:.  Clicking on the target volume input box or moving the volume slider will disable 
 the pressure regulation. 

See Analog Manifold Settings for more information on regulating a uPS pressure sensor via a 
channel setting.  

 

Optimizing Syringe Pump Performance 
The syringe pump is designed for optimal accuracy in the push (infuse) direction. The pump 
motor design includes an anti-backlash spring, which can cause minor volume inaccuracy in the 
pull direction. In addition, when changing the syringe direction from pull to push, or vice-versa, 
you may notice a slight delay before the syringe plunger starts advancing. The volume 
inaccuracy and duration of the delay will vary depending on the syringe size, set speed, system 
back pressure, and fluid viscosity.  

To improve the timing and volume accuracy of an infusion we recommend pushing a small 
volume of fluid prior to starting the timed infusion. For example, if you want to pull 10 ul of fluid 
from a reservoir and then push (infuse) it into a process, we recommend pulling 11 µl of fluid, 
then push 1ul back into the reservoir before switching your valve to the infuse position.  

Valve Manifold Control 

Click a valve manifold in the uDevices Window to view its control panel (Figure 20). 
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Figure 20. Controls for a 4VM01 valve manifold with AV201 or AV202 automated valves. 

The valve can be actuated to three positions(see Figure 21) as shown below. 

 

No change The valve state will not change, indicated as position “0” in script. 

A  The valve will allow flow to the left, indicated as position “1” in script. 

Closed The valve will close, indicated as position “2” in script. 

B  The valve will open flow to the right, indicated as position “3” in script. 

 
Figure 21. Shows the valve flow positions, looking down from the front of the valve.  

The indicator lights on the valve will illuminate when it is being actuated. A red light indicates 
that it is being actuated to the “A” position, while a green light indicates it is being actuated to 
the “B” position.  

If the current valve state is known, there will be a check next to the state and the  message 
below the valve will read “In position”. 

If the current valve state is unknown (i.e. if power to the EIB has been cycled), none of  the 
check boxes will be marked and the message below the valve will read “Indeterminate”. 

 NOTE: if valve cables are switched while the EIB is powered the valve states could be 
 incorrectly indicated.  Remove power to the EIB before changing valves or moving 
 cables.  

If Update Continuously is selected, the valve will move immediately when you select a new 
position, and the checj mark to the right of that position will be marked. When Update 
Continuously is not selected, choose the new position, then click Apply Settings Now to move 
the valve (the check mark for the new position will be then marked). 

The valve can also be instructed to set based on channel regulation status. 

 
AV201 Series (3-port) valve    AV202 Series (4-port) valve 
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  or  

Set via Ch. The valve will change states based on the regulation status (see Chapter 5).   

 If the valve is selected to move “With” the channel the default valve positions are: 

  Regulating up (pressure is too low): valve will move to position “B” 

  Regulation achieved (pressure is within range): valve will move to position   

  “Closed” 

  Regulating down (pressure is too high): valve will move to position “A” 

  

 If the valve is selected to move “Opposite” the channel the default valve positions are: 

  Regulating up: valve will move to position “A” 

  Regulation achieved: valve will move to position “Closed” 

  Regulating down: valve will move to position “B” 
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CHAPTER 5. AUTOMATED CONTROL 
An automated script is a series of steps for controlling one or more automated devices. Each 
step can change the state of multiple devices. A script can be created using the Process 
Wizard, and it can be created or edited using the built-in text editor.  

Opening Script Files 
Each automated script is stored as a file with a .usq extension. To open an existing script click 

the Open  toolbar button, then browse for the correct file. Its contents will appear in the 

Main Window (Figure 22). 

 
Figure 22. Text of an Automated Process. 

Create a Script Using the Wizard 
The Process Wizard provides a simplified interface for quickly generating automated scripts. 

Note:  Each installed syringe pump and 4VM01 must have a unique name, regardless of 
whether it is used in an automated script. See Device Name. 

To create a script using the Process Wizard: 

Click the New toolbar button, or choose File>New. If a process is currently open, its contents 
will be copied into this new script. 

Select the uDevices Window. 

Click Interfaces to view the 

. 

Set the initial target state for each device. 

Click the Save as New Sequence Step  button. The Creating a New Sequence Step dialog 

box will open (Figure 23). 
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Figure 23. Creating a New Process Step Dialog Box. 

If desired, enter a descriptive Step Name. Step names may have a maximum of 16 characters 
and may not include blanks or ‘;’, ‘<’, ‘>’, ‘*’ or ‘=’.  

Select how the script should respond after changing the uDevice settings: 

Select Pause, then enter the duration to pause before continuing with the process. The pause 
duration begins as soon as the step starts. 

If you select Wait until all devices are finished, uProcess will wait until all devices have 
completed their functions before continuing on with the process. 

Select Do Not Wait to immediately continue on to the next step. 

Select how the script should continue after this step: 

Select Continue to continue to the next step in the process. If a new step is not added the 
process will end. 

Select Loop to step to jump to another process step. Select the target step from the drop-down 
list, then enter the number of times the step should loop.  

Click OK. The step will appear in the Sequencer Window, and its text will appear in the Main 
Window. 

Save a Script File 
Click the Save toolbar button, or choose File>Save, to save all changes to the current script file. 
If the file has not yet been saved you will be prompted to provide a name and file location for it. 

Choose File>Save As to store the current script under a new file name. 

Run, Pause and Quit a Script 

When a script is open and error-free, the Run  toolbar button will be available. Click Run to 

initiate the process. All steps will be performed in order. 

While a script is running you can click the Pause  toolbar button to pause the automated 

process. Click Pause again to continue the script from that point. 
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Click the Quit Process  toolbar button to quit running the automated script.  

Note: When you Pause or Quit a script, devices that were moving will continue until they 

reach their target states. Click the Stop All Devices  toolbar button to stop all 

device activity. 

While an automated script is running, the Sequence Progress tab of the Output Window will 
indicate the current status of the script and will report any errors encountered (Figure 24). 

 
Figure 24. Sequence Progress Tab of the Output Window 

. 
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Automated Script Functions 
 
Beep:   <Beep>    

Plays an audible sound (the sound associated with with the Asterick in System Sounds).  

Example:   <Beep>   

Note:    The Beep function cannot be added using the Process Wizard. 
 

Break   <Break>   

 Automatically activates the pause  toolbar button, pausing Sequence until the 

pause toolbar button is pressed. This function is useful for testing a script, or if you have 
an event with unpredictable timing that you need to wait for before resuming a script. 

Example:   <Break>  

Note:    The Break function cannot be added using the Process Wizard 

  
Goto  <Goto> StepName 

Creates a loop back to named step. 

StepName  defined name of step in script 

Example:	 <Goto> FillStep 

 

HysteresisRegTo   (regulates both up and down) 
HysteresisRegUpTo  (regulates up only) 
HysteresisRegDownTo (regulates down only) 

    DeviceName: HysteresisRegTo Ptarget Ptolerance units   
 

Regulates between target pressure +/- tolerance.  uProcess will regulate to Ptarget and 
then let the pressure drift until it falls outside the tolerance range. 
 
DeviceName: defined name of uPS pressure sensor (must be defined in script header) 
Ptarget: target pressure 
Ptolerance: pressure tolerance (+/-) 
units:  pressure units 

 
Example:	 HysteresisRegTo 40 1 kPa 
 

HysteresisRegTo to Channel  (regulates both up and down) 
HysteresisRegUpTo to Channel  (regulates both up and down) 
HysteresisRegDownTo to Channel  (regulates both up and down) 
 
     DeviceName: HysteresisReg Ptarget Ptolerance units  to ChX 
 

Similar to HysteresisRegTo, except it sends the output value to a specified channel that 
 can be used to control a SPS01 syringe pump. Requires two lines of code:   
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DeviceName: HysteresisRegTo Ptarget Ptolerance units  to ChX 
SyringeName: MoveWith ChX    or   SyringeName: MoveOpposite ChX 

 
DeviceName: defined name of uPS pressure sensor (must be defined in script header) 
Ptarget: target pressure 
Ptolerance: pressure tolerance (+/-) 
units:  pressure units 
 
SyringeName  defined name of syringe pump (must be defined in script header) 
X   channel A, B, C, or D 

 
 MoveWithChX: pulls the syringe to decrease the pressure 
    pushes the syringe to increase the pressure 
 
 MoveOppositeChX: pushes the syringe to decrease the pressure 
    pulls the syringe to increase the pressure 
  

 
Example: HysteresisRegTo 40 1 kPa to ChA 

   SPS01: MoveWith ChA 

 
IfDone  DeviceName: IfDone 

If regulation is done, the immediately following step will be  executed; otherwise, the 
 immediately following step will be skipped. 

 
DeviceName: defined name of uPS pressure sensor (must be defined in script header) 
 

 Example:	 uPS1 : IfDone 
   <Beep> 

 Note:    The IfDone function cannot be added using the Process Wizard 
 
IfNotDone  DeviceName: IfNotDone 

If regulation is not done, the immediately following step will be executed; otherwise, the 
 immediately following step will be skipped.  

 
DeviceName defined name of uPS pressure sensor (must be defined in script header) 
 

 Example:	 uPS1 : IfNotDone 
   <goto> Step1 

 Note:    The IfNotDone function cannot be added using the Process Wizard 
 
Loop  <Loop> StepName cycles 

Loops back to named step for specified number of cycles. 

StepName: defined name of step in script 

cycles:  number of times to loop;  

Example:	 <Loop> FillStep 6 

Note: For an endless loop, use the <Goto> command. 
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MoveTo SyringeName: MoveTo vol units 

Sets syringe move to position. 
 
SyringeName  defined name of syringe (must be defined in script header) 
vol    syringe volume to move to 
units   volume units, acceptable units include 

ul (default) 
ml 
nl 

 
Example: Reagent: MoveTo 20.5 ul  

 
Pause  <Pause> duration units  

Pauses script for specified duration. 
 
 Duration  length of pause 

units   pause duration units, acceptable units include 
ms (default) 
s 
us 

 
Example: <Pause> 1 s  
 

SetFlowRate SyringeName: SetFlowRate rate units;  

Sets syringe flow rate. 
 

SyringeName  defined name of syringe (must be defined in script header) 
rate    syringe flow rate (positive number) 
units   flow rate units, acceptable units include 

ul/min (default) 
ul/s 
nl/min 
nl/s 

 
Example: Reagent: SetFlowRate 50 ul/s 

 
SetValves 4VM01Name: SetValves x x x x    

Sets valve positions. 
 
4VM01Name  defined name of 4VM01 (must be defined in script header) 
x x x x   position of valves 1, 2, 3, and, 4, respectively, where 

x = 0 no change 
x = 1: open valve to ‘A’ 
x = 2: close valve 
x = 3 open valve to ‘B’ 

 
 Example:  4VM01_A: SetValves 1 0 3 2 
 
Stop  DeviceName: Stop  
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Stops device. 
 
DeviceName defined name of 4VM01 or syringe (must be defined in script header) 
 
Example: Reagent: Stop  

 Note:  The Stop command is added via the Process Wizard using the  button (Stop 

 this uDevice) in the Device Control Overview window. 
 
Quit       <Quit> 

 Quits the script, steps following this function will not be run. This function will not stop a 
 device that is already in process, for that use the Stop function. 

Example:   <Quit>   

Note:    The Quit function cannot be added using the Process Wizard. 

 
RegDownTo and RegUpTo 

 
SensorName: RegDownTo value units; regulation is complete when sensor pressure 

 reaches or drops below input value 
  
 or 

 
SensorName: RegUpTo value units; regulation is complete when sensor pressure 

 reaches or exceeds input value 
 
SensorName  defined name of sensor (must be defined in script header) 
value    pressure (positive or negative number) 
units   pressure units, acceptable units: kPa 

 
Example: P032: RegDownTo 50 kPa 

 

RegDownTo Channel or RegUpTo Channel 

Similar to RegDownTo and RegUpTo, except it sends the output value to a 
 specified channel which is used to control one or more SPS01 syringe pump.    

 
Requires two lines of code: 
 
SensorName: RegDownTo value units to ChX 
SyringeName: MoveWith ChX    or   SyringeName: MoveOpposite ChX 

 
or 
 
SensorName: RegDownTo value units to ChX 
SyringeName: MoveWith ChX    or   SyringeName: MoveOpposite ChX 
 
SensorName  defined name of sensor (must be defined in script header) 
value    pressure (positive or negative number) 
units   pressure units, acceptable units: kPa 



 

38 

 
SyringeName  defined name of syringe pump (must be defined in script header) 
X   channel A, B, C, or D 

 
 MoveWithChX: pulls the syringe to decrease the pressure 
    pushes the syringe to increase the pressure 
 
 
 MoveOppositeChX: pushes the syringe to decrease the pressure 
    pulls the syringe to increase the pressure 
  

 
Example: P032:  RegDownTo 50 kPa to ChA 
  SPS01: MoveWith ChA 

 

 Note:    Use the SetFlowRate command to set the syringe pump flow rate for each 
 syringe, else the last flow rate set for the syringe will be used. 

 
RegOff  SensorName: RegOff 

Turns off the regulation for a pressure sensor. 
 
Example: 032: RegOff  

 

WaitAllDone <WaitAllDone>  

Pauses script until all processes are complete. 
 
Example: <WaitAllDone>  

 

General Formatting Rules 
Devices  

Individual devices are defined in the script as follows: 

Syringes: 

*DeviceName = SPS01 size ul 

Where size is the syringe size (4, 8, 20, 40, or 80) 

Valve Manifolds 

  *DeviceName = 4VM01 

DeviceName must match name defined in the uDevice configuration (see Device Naming and 
Numbering). 
 
Note: When referring to a device in the script the device name cannot start in the first column 
of a row.  Insert a space or tab before the name. 

 
Comments  
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Comments can be added to the script using a semicolon (;). Anything after the semicolon is 
treated as a comment: 
 <Pause> 1000 ms; to allow time to monitor reaction 

 

 ; <Beep> - this command will not be executed 

 
Step Name 

Step names may have a maximum of 16 characters and may not include blanks or ‘;’, ‘<’, ‘>’, ‘*’ 
or ‘=’.  The Step Name must start in the first column of a row, do not add a space or tab before a 
step name. 

 

Editing Automated Script Text 
As mentioned earlier, you can create a script using the Process Wizard, or you can create/edit 
the text directly. 

To view and edit the text of a script, click on the Sequencer window, then select Sequencing 
Script. The text will appear in the Main Window. Here is a sample script: 

 

 

 

The first lines define the devices used in the script. Note that the devices are defined by name 
rather than address, so the names of all devices must be unique. 

Below these declarations, each step is listed in order. For clarity, all state changes within each 
step are indented below the step name. 

When learning to edit the text it may prove helpful to create a script using the Wizard, then to 
edit the generated text as the basis for your new script.  

Most standard text editing functions are available, including Cut, Copy and Paste. 

*Syringe=  SPS01 20 ul 
*Manifold=  4VM01 
Open_Reservoir 
 Manifold: SetValves 1 0 0 0 
 <WaitAllDone> 
Fill_Syringe 
 Syringe: SetFlowRate 50 ul/min 

Syringe: MoveTo 10 ul  
 <WaitAllDone> 
Open_Process 
 Manifold: SetValves 3 0 0 0 
 <Pause>  1000 ms 
Deliver_Reagent  
 Syringe: SetFlowRate 10 ul/min 
 Syringe: MoveTo 0 ul 

<WaitAllDone> 
 <Loop>  Fill_Syringe 10  
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Script Errors 

uProcess will review the script as you create or edit it and will indicate errors as follows: 

 If the script has an error the Run button will be grayed out and the script cannot be run. 

 The Script Parsing tab of the Output window will display the message 

   ***The script cannot be run until the script errors are resolved*** 

 The Script Parsing tab of the Output window will also list the line number and specific 
 error. 

 The step with the error will show a “broken” icon in the Sequencing Script list. 

In the example shown in Figure 25, line 36 has an error. Device ‘water’ is not found, because 
the device was initialized as ‘Water’.  

 
Figure 25. Sample script showing errors in line.  

Missing Devices 

All of the devices referenced in a process must be available for the process to function. If you 
open or create a script which calls out a device that is not present, error messages will appear 
in the uDevices Windows, the Script Parsing tab of the Output Window, and the Main 
Window (Figure 26). 



 

41 

 

 
 

 
Figure 26. Error Message: Referencing a missing device. 

For this example, the script references “Dye”, but the syringe is named “Water”. This error can 
be resolved by renaming the device (see Device Naming and Numbering) or changing the 
script. To change the scrip: 

Right click on “Dye” under the Missing devices tab and select Rename … 

Change the name to “Water” and click OK. 

Example Script 
In the example shown in Figure 27 a syringe pump is attached to an automated valve, a supply 
reservoir and a downstream process. The syringe will first pull fluid from a reservoir connected 

Error Messages 
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to the “A” port of the valve. The valve will then switch to the “B” position, and the syringe will 
deliver the fluid to the downstream process. 

 
Figure 27. Hardware Setup for the Sample Process. 

For this example the following devices are installed on one EIB: 
- One 20µl syringe named “Reagent Syringe” 

- One 4VM01 manifold named “Reagent Manifold”, with one valve 
connected at position 1. 

The automated script is created as follows: 

In the uDevices Window select Interfaces to display the Error! Reference source not found. 
(Figure 28). 

 
Figure 28. Installed Devices Shown in Device Control Overview Window. 

Set the position for Valve 1 on “Reagent Manifold” to Open A. 

Depress the Do Not Change uDevice Settings  button next to the Reagent Syringe. 

Click the Save As a New Sequence Step  button. 

Name the new step “Open_Reservoir.” 
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Select Wait until all devices are finished and Continue. 

Click OK to add this step to the script and go on to the next step. 

Set the Target Volume for the syringe named “Reagent Syringe” to 10 µl and the Flow Rate to 
50 µl/min (Figure 29). 

 
 

 
Figure 29. Step “Fill_Syringe” Settings. 

Depress the Do Not Change uDevice Settings  button next to the Reagent Valve. 

Click the Save As a New Sequence Step  button. 

Name the new step “Fill_Syringe.” 

Choose wait until all devices are finished and Continue (Figure 30). 
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Figure 30. Step 1 Settings. 

Click OK to add this step to the script. To view the process thus far, click the Sequencer 
Window tab then click on any step in the sequencing script (Figure 31). Select Interfaces in 
the uDevices Window to return to the Error! Reference source not found. and continue building 
the script. 

 
Figure 31. Step 1 Shown in the Sequence Tab and Main Window. 

Set the position of Valve 1 to Open B and depress the  button for the Reagent Syringe. 

Click the Save As a New Sequence Step button and name the new step “Open_Process”. 

Choose Pause and set the time for 1 s (1000 ms). Choose Continue and select OK to go on to 
the next step. 

Set the Target Volume to 0 and the Flow Rate to 10ul/min and depress the  button for the 
Reagent Valve. 
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Click the Save as a New Sequence Step button. 

Name the step “Deliver_Reagent”. 

Select wait until all devices have finished. 

Select Loop to Step and choose Fill Syringe from the drop down menu. Set the loop count to 
10, and the process will repeat for 10 iterations. (Figure 32). 

 
Figure 32. Deliver_Reagent Step Settings. 

Click OK. Again, select the Sequencer Window tab and click on a step in the script to view the 
complete script (Figure 33). 

 
Figure 33. The Complete Example Script. 

Press the Run button to initiate the automated script. 
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When a script is running, the current step will highlighted in the Main Window to allow tracking 
of the script progress. The status of the devices and the step progression can be monitored real 
time. As shown in the figure below, the Error! Reference source not found. shows the real time 
positions of the syringes and valves; the Sequence Status tab of the Output Window shows 
which step is currently running and the number of iterations which have been completed. The 
bottom left corner of the window shows how long the script has been running (Figure 34). 

 

 
Figure 34. Sequence Status Tab 

Syringe Pump Volume vs Delivery Time 
In the above example the syringe is set to deliver 10 µl of reagent at 10 µl/min. In order not to 
overshoot the delivery of the reagent, the syringe will slow down just before reaching the target 
volume; therefore, the delivery time may be more than 1 minute. This is most pronounced when 
delivering at high flow rates.  

For some processes the infuse time may be more critical than the total delivery volume. For this 
case you can use the <Pause> and <Stop> functions together to set the infuse time. The script 
from the above example is shown below.  
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The total volume delivered is 10 µl, which at 10 µl/min should take approximately 1 minute. If a 
delivery time of exactly 1 minute is desired, the script could be modified as follows (changes are 
in bold): 

  
In the second example the syringe is instructed to stop after exactly 60 seconds, 
which will be after approximately 10 l is delivered. 

Pressure Regulation Example Scripts 
 
The uPS pressure sensors and SPS01 syringe pumps can be used together with the uProcess 
software to regulate the pressure in a device or create pressure driven flow.  In the simple 
pressurization example below, the SPS01 syringe pump is filled from the reservoir, and then it is 
used to pressurize a device.  When the pressure reaches 100 kPa the script is complete. 

*Syringe=  SPS01 20 ul 
*Manifold=  4VM01 
Open_Reservoir 
 Manifold: SetValves 1 0 0 0 
 <WaitAllDone> 
Fill_Syringe 
 Syringe: SetFlowRate 50 ul/min 

Syringe: MoveTo 10 ul  
 <WaitAllDone> 
Open_Process 
 Manifold: SetValves 3 0 0 0 
 <Pause>  1000 ms 
Deliver_Reagent  
 Syringe: SetFlowRate 10 ul/min 
 Syringe: MoveTo 0 ul 

<WaitAllDone> 
 <Loop>  Fill_Syringe 10  

*Syringe=  SPS01 20 ul 
* Manifold = 4VM01 
Open_Reservoir 
 Manifold: SetValves 1 0 0 0 
 <WaitAllDone> 
Fill_Syringe 
 Syringe: SetFlowRate 50 ul/min 

Syringe: MoveTo 11 ul ; provide extra volume so the  
    ; syringe won’t stop prematurely 

 <WaitAllDone> 
Open_Process 
 Manifold: SetValves 3 0 0 0 
 <Pause>  1000 ms 
Deliver_Reagent  
 Syringe: SetFlowRate 10 ul/min 
 Syringe: MoveTo 0 ul 

;<WaitAllDone>  this command is commented out 
 <Pause>  60 s ;allow the syringe to run for 60 s 
 Syringe:  Stop  ;stop the syringe 
 <Loop>  Fill_Syringe 10  
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Simple pressure regulation application (uPB-05 breadboard, 4VM manifold, and 4AM manifold 
not shown for clarity) 
 

Simple Pressure Regulation Example Script 

 
 
One potential issue with the above script is if the syringe reaches the end before the pressure 
reaches 100 kPa the script will never complete.  To account for this condition, the last step 
(“Pressurize”) can be changed to include a loop that looks to see whether the syringe has 
finished.  If the syringe finishes before the pressure is reached, the valve switches back to the 
reservoir to refilled the syringe and then the device is pressurized again.  This script is shown 
below. 
 

*SPS01 = SPS01 80 ul 
*uPS  = uPS01 800 kPa 
*4AM  = 4AM01 
*4VM   = 4VM01 
 
Switch_Fill ; switch valve to “fill” position 
 4VM:  SetValves 1 0 0 0 
 4VM:  WaitDone 
 
Fill   ; fill syringe with liquid from reservoir 
 SPS01: SetFlowRate 150 ul/min 
 SPS01: MoveTo 80 ul 
 SPS01: WaitDone 
 
Switch_Dispense ; switch valve to “dispense” position  
 4VM:  SetValves 3 0 0 0 
 4VM:  WaitDone 
 
Pressurize 
 uPS:  RegUpTo 100 kPa  
 SPS01: SetFlowRate 20 ul/min 
 SPS01: MoveTo 0 ul 
 uPS:  WaitDone 
 SPS01: Stop ; stop the syringe pump 
 4AM:  Stop ; stop the regulation 
 <Beep>  ; indicate script is complete 

Valve 1 

uPS SPS01 

reservoir 
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Pressure Reguation Example Script with auto re-fill of syringe if pressure is not reached 

 
 
The uProcess system can also be used to create near-constant pressure flow, as shown in the 
following pinched flow application example.  Fluorescent dye is injected in the main leg of a 
cross chip and water is injected in the two cross arms to create pinched flow across the width of 
the channel.  A reservoir (BB_RES) out fitted with an o-ring and cap is placed upstream of each 
chip inlet.  Each reservoir is partially filled with the corresponding liquid (dye or water), leaving 
an air gap at the top to allow flow dampening.  A uPS pressure sensor is installed in the cap of 
the reservoir to monitor and regulate the pressure.  
 
 
 

*SPS01 = SPS01 80 ul 
*uPS  = uPS01 800 kPa 
*4AM  = 4AM01 
*4VM   = 4VM01 
 
Switch_Fill ; switch valve to “fill” position 
 4VM:  SetValves 1 0 0 0 
 4VM:  WaitDone 
 
Fill   ; fill syringe with liquid from reservoir 
 SPS01: SetFlowRate 150 ul/min 
 SPS01: MoveTo 80 ul 
 SPS01: WaitDone 
 
Switch_Dispense ; switch valve to “dispense” position  
 4VM:  SetValves 3 0 0 0 
 4VM:  WaitDone 
 
Pressurize 
 uPS:  RegUpTo 100 kPa  
 SPS01: SetFlowRate 20 ul/min 
 SPS01: MoveTo 0 ul 
Check_Loop 
 SPS01: ifdone 
 <Goto> Switch_Fill 
 uPS:  ifdone 
 <Goto> Finish 
 <Pause> 1 s 
 <Goto> Check_Loop 
Finish  
 SPS01: Stop ; stop the syringe pump 
 4AM:  Stop ; stop the regulation 
 <Beep>  ; indicate script is complete 
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Pressure regulated hydrodynamic flow application (iBB breadboard, 4VM manifold, and 4AM 
manifold not shown for clarity) 
 
The script below will: 

1. Switch_Fill: open the valves to the open reservoirs; 
2. Fill: fill the syringes; 
3. Switch_Dispense: open the valves to the chip; 
4. Regulate: dispense the syringe fluids toward the chip 

DYE 
a. Dye_80 syringe dispenses until reservoir_1 pressure reaches 46 kPa 
b. Dye-80 syringe stops, pressure monitored until pressure   drops below 45 kPa  
c. water dispense until reservoir_2 pressure reaches 37.5 kPa 

Water_80 

Dye_80 

Water 

Dye 

Valve 1 
Waste 

reservoir with 
uPS_2 

reservoir with 
uPS_1 

Valve 2 

Cross chip 

Y interconnect 
(splitter) 
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Constant-pressure pinched flow example script. 
 
The above script will run continuously until it is manually stopped. 
 

*uPS_1 =  uPS01 800 kPa 
*uPS_2 =  uPS01 800 kPa 
*Dye_80=  SPS01 80 ul 
*Water_80 = SPS01 80 ul 
*4AM =  4AM01 
* 4VM =  4VM01 
 
Switch_Fill ; switches valves to “fill” position 
 4VM:  SetValves 1 1 0 0 
 4VM:  WaitDone 
Fill   ; fills syringes with liquid from reservoirs 
 Water_80:  SetFlowRate 150 ul/min 
 Water_80:  MoveTo 100 ul 
 Dye_80:  SetFlowRate 150 ul/min 
 Dye_80:  MoveTo 100 ul 
 Water_80:   WaitDone 
 Dye_80:  WaitDone 
 
Switch_Dispense ; switches valves to “dispense” position  
 4VM:  SetValves 3 3 0 0 
 4VM:  WaitDone 
 
Regulate ; dispense the syringes to pressurize the reservoirs,  
  ; when the pressure reaches max set value syringes will 
  ; stop pumping & wait until pressure has dropped below 
  ; min value 
 Dye_80:  SetFlowRate 100 ul/min  
 uPS_1:  HysteresisRegTo 45 1 kPa to ChA 
 Dye_80:  MoveWith ChA 
 Water_80:  SetFlowRate 100 ul/min 
 uPS_2:  HysteresisRegTo 37 0.5 kPa to ChB 
 Water_80:  MoveWith ChB 
 
CheckRegulation ; loop that checks if either syringe is empty (at 
   ; 0) and switches to refill if so 
 Water_80: ifdone 
 <Goto> Switch_Fill 
 Dye_80: ifdone 
 <Goto> Switch_Fill 
 <Pause> 1 s 
 <Goto> CheckRegulation 
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EXTERNAL INSTRUMENTS 
The uProcess software supports several USB- or RS232-controlled instruments  Please contact 
LabSmith for information and instructions on supported instruments.  
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APPENDIX A. MENUS, TOOLBARS, WINDOW CONTROLS 

Menu Bar 
The menus contain the following functions:  

File Open, Close, Save, Print or create a new automated process.  

Edit Cut, copy or paste text while editing an automated process.  

View Choose which uProcess windows and toolbars are displayed. 

Actions Run, Pause or Stop an automated process, control hardware communications, 
and update firmware. 

Click and drag the three dots at the left of the menu bar to tear it from the main window as a 
floating palette. Click and drag the floating palette back into the main window to re-dock it. 

Toolbar 
Toolbar buttons provide one-click shortcuts to common tasks. Buttons are gray when those 
functions are not currently available. 

 
Figure 35. uProcess Toolbar Buttons. 

 New (ctrl-n) Create a new automated process 

 Open (ctrl-o) Open an existing automated process 

 Save (ctrl-s) Save the current automated process 

 Cut (ctrl-x) While editing an automated process, delete selected text and place it on 
the clipboard 

 Copy (ctrl-c) While editing an automated process, copy selected text to the clipboard 

 Paste (ctrl-v) While editing an automated process, paste text from the clipboard 

 Print (ctrl-p) Print the text of an automated process 

 About uProcess Find the uProcess version number. This window also contains 
links to the electronic version of this User Manual, the LabSmith web site, and LabSmith tech 
support. 

 

 Run/Pause/Quit Control the progress of an automated process. 
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 Stop all devices Stop all activity of all uProcess devices. 

 Re-scan devices Check for all connected uProcess devices. 

 Online Establish communication between the EIB and computer. 

Tip: You can also use keyboard shortcuts, shown in parentheses in the list above, to 
perform the commands. 

To toggle toolbar buttons on or off, click the down arrow on the right side of the toolbar, then 
choose Add/Remove Buttons>Standard. Choose Reset Toolbar to show all buttons. 

Click and drag the three dots at the left side of the toolbar to tear it from the main window as a 
floating palette. Click and drag the floating palette back into the main window to re-dock it. 

Choose View>Toolbars and Docking Windows>Standard to show or hide the toolbar.  

Tooltips 
Each toolbar button (and many other buttons in uProcess) includes tooltip text that appears 
when you position your cursor over the button. Tooltips explain a tool’s function. Choose 
View>Verbose Tooltips to view more extensive descriptions (Figure 36). 

 
Figure 36. Tooltips Provide Helpful Tool Descriptions. 

Customizing the Dashboard 

Show/Hide Dashboard Elements 

From the View menu choose Toolbars and Docking Windows. From this menu option you can 
choose to show or hide the toolbar, uDevices Window/Sequencer Window and Output Window. 

Auto‐Minimize Windows 

Click the “push-pin” button at the upper right of the uDevices Window/Sequencer Window or 
the  Output Window to minimize the window to the edge of the screen. Roll over a minimized 
window to make it reappear; it will automatically minimize when you roll the cursor off of the 
window. The push-pin button will be horizontal in this “auto-minimize” mode. Click the button 
again to turn it vertically and disable auto-minimizing. 

Detach, Dock and Re‐Position Windows 

Click and drag the top of the uDevices Window/Sequencer Window or the Output Window to 
detach it from the Dashboard and create a floating window. Drag the floating window over the 
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Dashboard to dock it. Positioning guides will appear as you do so to help you attach the window 
at the top, bottom, left or right of the uProcess Dashboard (Figure 37). 

 
Figure 37. Positioning Guides for Re-docking a Window. 
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APPENDIX B. MAINTENANCE 

Updating Firmware 
The firmware for all uProcess devices can be field updated as follows: 

Download the latest version of uProcess software from www.labsmith.com. 

Choose Actions>Firmware>Update All Firmware. uProcess will upload the latest firmware 
associated with the installed software to all connected syringe pumps, 4VM01 valve manifolds, 
and 4AM01 analog manifolds. Devices that are not attached will not be updated. 

Note:  AV200 series automated valves and uPS01 series pressure sensors do not have 
firmware and therefore do not need to be connected for firmware updates.  

Note:  You can update the firmware for a particular device by clicking the Configuration 
button in the device control panel.  

uProcess devices are factory configured for optimal performance. From time to time it may be 
necessary to access and adjust these settings.  

Valve Actuation Profile Settings 
Click the Configuration button to open the Configure Device dialog box shown in Figure 38.  
The Actuation profile settings control the motor actuation duration and current.  These 
settings may need to be adjusted as your valves and motors age.  However, the user should 
contact LabSmith before changing any of the Actuation Profile Settings, as incorrect settings 
can cause excessive wear of the motor or prevent the motor from reaching its set possition.  

  
Figure 38. Configure Device Dialog Box for a 4VM01 Valve Manifold. 
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Changing the Syringe Pump Glass Assembly 
The SPS01 syringe glass and plunger can be removed from the pump body to be cleaned or 
exchanged with a different syringe size. To remove the syringe glass and plunger: 

1. Supply power to the syringe pump. 

2. In the uProcess uDevices Window, select the syringe. 

3. Enter a Set Point of 0 to extend the syringe plunger to the 0 volume position. 
 

 

4. Click Offline to take the syringe offline. 

5. Unplug the syringe from the breadboard. 

6. Using the supplied hex wrench, loosen the screw located on the side of the syringe. 

 

 

7. Gently pull the syringe glass straight out of the syringe body, being careful not to bend 
the syringe plunger. 

8. While holding the wide end of the plunger installation wrench, insert the wrench around 
the plunger tip and into the syringe until it engages with the hex head at the base of the 
syringe plunger. 
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CAUTION:  Be very careful not to damage Teflon end of the plunger. Damage to the 
plunger can cause the syringe to leak.  

9. Turn the wrench counterclockwise approximately two revolutions to unscrew the plunger. 

10. Gently pull the wrench and plunger out of the syringe. 

CAUTION: Do not operate the syringe without a plunger installed. Doing so can 
damage the syringe.  

To install the syringe glass and plunger: 

1. While holding the wide end of the plunger installation wrench, insert the plunger 
assembly into the wrench such that the hexagonal feature on the plunger is engaged 
with the wrench.  

2. Gently insert the plunger assembly into the syringe and screw onto the shaft until hand 
tight (approximately two revolutions). 

3. Carefully press the tapered glass syringe over the plunger assembly and into the syringe 
until it is seated in the syringe body.  

4. Use the hex wrench to tighten the screw located on the top side of the syringe.  

5. Gently pull on the syringe glass to ensure it is secure in the syringe body. 

6. The glass size value must be input in the software each time you change the glass size 
to allow uProcess to display and compute correct volumes and volume flow rates. To 
select the correct glass size: 

7. Click on the device in the uDevices Window. 

8. Select Configuration. 

9. Choose the syringe pump glass size from the Size drop-down list.  

10. Follow instructions for calibrating, below. 

CAUTION:  Ensure you are using the correct size plunger for your syringe glass. 

Calibrating the Syringe Pump 
Each SPS01 syringe pump is calibrated before shipment. However, each glass/plunger 
assembly may have slight length variations (up to 1%), and there can also be variations in the 
placement of the glass in the syringe body.  

Each time the syringe glass is removed or moved the syringe pump should be recalibrated. 
Calibrating the syringe pump allows uProcess to find the plunger stopping point, thereby 
minimizing the dead volume within the syringe and allowing correct calculation of the syringe 
volume. 

Note:  Calibrating the syringe will run the syringe to its maximum extents and will update its 
calibration values. The procedure may take up to 1 minute. 

To calibrate the syringe: 

Select the device in the uDevices Window. 

Select Configuration to open the Syringe Pump Configuration dialog box (Figure 39). 
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Figure 39. Syringe Pump Configuration Dialog Box. 

Click the Calibrate button.  

Select OK to store the values.  

Tip: To obtain the maximum volume of the syringe pump.  Remove the syringe glass from the 
SPS01 (but leave in the plunger) and run the calibration.  Then replace the syringe glass, 
carefully pushing the syringe glass back until it hits the end of the plunger.  Rerun the calibration 
after tightening the syringe glass in place.  

Care of the Syringe Glass and Plunger 

Plunger Care 

Do not apply excessive force to move a plunger. Too much pressure can irretrievably bend the 
plunger or easily crack the syringe’s glass barrel. 

Avoid touching the plunger with your fingers. Abrasions, scratches, or oil due to handling the 
plunger with your fingers may interfere with proper plunger operation. 

To minimize the chance of damage or contamination, do not store the plunger outside the glass. 
Use caution when reinserting the plunger into the barrel using the plunger installation tool.  

For best results, dip the PTFE plunger tip into your solvent to re-wet it prior to reinserting the 
plunger into the barrel. 

Cleaning, Sterilizing, Autoclaving, and Disinfecting 
 
Cleaning 

To clean syringes, it is best to use solvents known to be effective in solvating the sample. 
Preferred cleaning agents are non-alkaline, non-phosphate and non-detergent based. A 
biodegradable, non-phosphate, organic Cleaning Concentrate is available from Hamilton 
Company (Part No. 18311, www.hamiltoncompany.com). 
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Rinse the syringe after use with an appropriate solvent or cleaning agent. Following the use of a 
cleaning agent, rinse the syringe with deionized water and finally acetone. Wipe the exterior 
surfaces of the syringe barrel and needle dry with a lint-free tissue. Make sure that there is no 
residual cleaning agent in the syringe before using or storing the syringe. Do not soak or 
submerse the entire syringe in any cleaning agent. Prolonged contact with cleaning agents may 
damage bonded parts. 
 
Sterilizing 

Syringes may be sterilized with appropriate sterilizing agents such as ethylene oxide. 
 
Autoclaving 

Syringes can be autoclaved up to a temperature of 115 ºC. However, please be aware that over 
time autoclaving will shorten the syringes’ life expectancy. Avoid rapid temperature changes, 
which can lead to splitting of the syringe’s glass barrel. Stainless steel expands faster than glass 
upon heating, so for most terminations, autoclaving strains glued surfaces and may eventually 
lead to adhesive deterioration and leakage. The plunger should be removed from the syringe 
before autoclaving. 
 

Capillary and Tubing Installation Guide 
LabSmith’s CapTite™ one-piece fittings enable connection of components (valves, syringe 
pumps, interconnects, bonded-port connectors, Luer Locks, and cartridges) to 360um capillary, 
1/32” tubing, or 1/16” tubing. To install the capillary or tubing: 

Cut the capillary or tubing to length. Please refer to the capillary or tubing packaging for cutting 
instructions. 

Insert the capillary into the nut end of the one-piece fitting until the tubing extends through the 
tapered ferrule end approximately 2 mm. 

Insert the one-piece fitting into the component and turn the fitting to finger-tighten.  

CAUTION:  Do not over-tighten the fitting. Fittings should only be “finger-tight” to avoid 
damage (the 1/8” hex wrench can be used to tighten or loosen difficult-to-reach 
fittings). 

Gently pull on the capillary tubing to ensure that it is held securely by the fitting. If the capillary 
comes free, loosen the fitting and repeat steps 2 and 3. 

If the fitting leaks or the capillary cannot be secured, the following troubleshooting items should 
be checked prior to further tightening the fitting: 

The capillary may be cut too short and so it is not protruding through the end of the fitting when 
installed 

The capillary may not have a “clean cut”. An angled or jagged edge will cause the fittings to leak 

Broken capillary or other debris may be stuck inside the fitting or component. Try flushing the 
port from the opposite side to clear the debris. 

If pressures greater than 10,000 psi are required, first finger-tighten all fittings and test for leaks 
at low pressure. Then, use the 1/8” hex wrench to tighten the fittings approximately ¼ extra 
revolution. 

Figure 40 shows capillaries that are properly and improperly installed: 
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- Red capillary does not protrude through the one-piece fitting. The fitting 
will leak, and also there is a chance of compressing and damaging the tip 
of the one-piece fitting during installation. 

- Yellow capillary may properly seal, but the capillary is not fully seated in 
the interconnect, creating dead volume. 

- Green capillary is properly installed.  

 
Figure 40 T-Interconnect Showing Properly Installed Capillary (Green), Improperly Seated Capillary 

(Yellow), and Capillary Not Protruding Through Fitting (Red). 

 


